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Arteriograph Software 
 
Copyright © 2022 TensioMed Ltd., Budapest, Hungary. All rights reserved. Under the copyright laws, 
this manual cannot be reproduced in any form without prior written permission of TensioMed Ltd. 
 
Every effort has been made to ensure that the information in this manual is accurate. Succeeding 
models and manuals are subject to change without notice.  
 
This Manual is produced on the assumption that the operator is an experienced user of the Windows 
10 or 11 operating system. 
If the operator is not familiar with Windows operations, please refer to online help of Windows or 
the Windows User Manual. 
 
Arteriograph is an unregistered trademark of TensioMed Ltd. 
Other company and product names mentioned herein may be trademarks of their respective 
companies. 
 
 
 
 
Head office and service: 
 
TensioMed Ltd. 
Kossuth Lajos Street 97.   
Budapest H-1181 
Hungary 
Phone:  (+36) 70 886 7337 

(+36) 70 315 6197 
Web:  www.tensiomed.com 
E-mail:  info@tensiomed.com 
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1. Introduction and determination of the intended use of the device 

1.1 Preface and determination of the intended use of the device 

 
Thank you for choosing Arteriograph.  
The intended use of Arteriograph is for non-invasive examination of brachial blood pressure, heart 
rate, and central hemodynamic parameters in a medical office. The intended use of the instrument is 
also to assess the hemodynamic changes created by various factors affecting the arterial circulation 
(therapeutic effects, physiological changes). Furthermore, the Arteriograph can be used in all areas 
where non-invasive examination of central hemodynamic parameters is considered necessary by the 
physician. It is advisable to use the instrument for patients where knowledge of aortic blood pressure 
and other central arterial functional parameters is desired, but the physician considers that the risk 
of measurement with a catheter or any other invasive method outweighs the benefits of knowledge 
of the parameters. 
Arteriograph is intended and validated for a patient population above 3 years of age.  A significant 
number of independent studies prove the safe and effective use of the device for patients during 
pregnancy as well. 
Arteriograph is a multiple-use device. The Arteriograph device cannot be connected to any other 
instrument. 
Arteriograph is a professional medical instrument and cannot be used in a home environment, i.e., 
patients cannot use it on their own. 
If the patient has a pacemaker, this does not affect the applicability of the Arteriograph. 
If the patient's physiological functions are monitored with other instruments (eg ECG, respiratory 
rate, temperature, oxygen saturation), this does not affect the applicability of Arteriograph. Do not 
use the device on patients if high frequency electrosurgical equipment is applied on them. 
For a patient being in a hyperbaric oxygen chamber, the Arteriograph should not be used. 
In case of a skin disease or wound on the upper arm where the cuff is planned to be placed, the 
Arteriograph measurement should not be performed. 
The device cannot be used in case of atrial fibrillation and in other forms of severe arrhythmia 
(bigeminy or trigeminy) or severe tremor (e.g. Parkinson disease). There is no risk to the patient’s 
health when using the device even in these cases, but the device will most probably not provide any 
valid measurement results. The less severe forms of arrythmia do no influence the accuracy of the 
device. 
Regarding brachial blood pressure, the limit values and therapeutic recommendations formulated in 
the valid national and international methodological guidelines for hypertension apply. 
Unfortunately, the limit values and application recommendations for arterial functions (PWVao, Aix-
ao, SBPao, RT, SAI, DAI, DRA) in methodological guidelines are currently not yet available, although 
many studies have been performed to determine the clinical value of these parameters. 
 
The device is explicitly designed for professional (clinical) use, not for public use. In the international medical field, the 
standard language is English, and the doctors communicate in English internationally. Thus, we identified the language 
requirements, and found English to be the proper international language for the markets of all EU member states. 
Furthermore, execution of multiple translations would result in a higher risk factor of ambiguous information due to unique 
linguistic properties of different languages. Even the best translation could result in misunderstandings of medical terms, 
especially in the field of arterial stiffness, of which terms can hardly be translated to the national (local) languages.  
 

1.2 The purpose of this manual 
 
This manual helps you in setting up and starting to use the Arteriograph (version: TL2) device as well 
as installing and setting up (on Windows 10 or 11 OS) the Arteriograph Software. 
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Please read this User Manual carefully before commissioning. 

 

 
Attention! Before first use, please read and understand this document 
carefully. 

 

1.3 General information 

 

• The principle of Arteriograph's operation is based on a patented, innovative solution. The 

cuff placed on the upper arm first measures the patient's blood pressure using an 

oscillometric method. After a few seconds, the instrument will re-inflate the cuff to the 

currently measured diastolic value and then to the so-called “suprasystolic” pressure, in both 

cases for 4-10 seconds (adjustable length). Then the instrument deflates the cuff after the 

third (the suprasystolic) phase, i.e. the measurement is completed. The whole process takes 

up to 2 minutes. During the measurement described above, the instrument continuously 

transmits signals to the program running on the computer, where oscillometric curves 

generated by pulsation of the vascular wall can be observed in real-time display on the 

screen. Upon completion of the measurement, the algorithm running in the computer 

program analyses the signals (waveforms) and calculates the blood pressure and arterial 

function parameters. 

 

• When active, the device does not cause any electromagnetic disturbance and its immunity to 

environmental effects is also sufficient. The measurement data are transmitted to the PC 

through wireless Bluetooth communication. The electromagnetic compatibility between the 

device and the PC is guaranteed (see Section 7.1 for details). 

 

• To ensure the optimal performance and precise operation, the device should be calibrated at 

the manufacturer’s service every 18-24 months and examined every 3 years. 

• Cleaning or disinfection of the cuff sleeve should happen on demand. Under the cuff a light, 
thin shirt can be worn.  

For disinfecting the cuff sleeve the recommended materials are:  

a., Alcohol based disinfectant  

b., Isopropanol (70%)  

Please follow the manufacturer's instructions for the use of these cleaners and leave the 
solution to dry completely.  

Avoid disinfecting the cuff bladder and the connected rubber tube. Before the disinfection, 
pull the bladder and the tube carefully out from the cuff sleeves, until the material allows. 
The bladder and tube may be damaged by disinfectants.  
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Do NOT use disinfectants that leave a residue on the product, or which are unsuitable for use 
in contact with skin.  

Some patients have intolerances (e.g. allergies) to disinfectants or their components. If you 
have such a patient or you are not sure, remove possible residues with careful washing. After 
removing the hose with the tube from the cuff, the remaining material can be washed in a 
washing machine at max. 30 °C using a mild washing powder (do not spin). Do not use fabric 
softeners or other aids (e.g. disinfectant rinses, textile deodorants). For drying do NOT use 
tumble dryer. It is important to ensure that the disinfectant is washed off completely before 
setting the cuff in place. Attention, there must be no residual disinfectant on the blood 
pressure cuff before setting it onto the upper arm.  
The Velcro must always be fastened before washing. 

• The manufacturer’s products should be handled, stored, packaged, protected, and shipped in 

compliance with the general quality requirements. 

• The device meets the requirements of the next standard:  
o IEC 80601-2-30:2018 Medical electrical equipment — Part 2-30: Particular 

requirements for basic safety and essential performance of automated non-invasive 
sphygmomanometers 

 

 
Attention! Federal Law restricts this device to be used by or on the order of a 
physician, or other licensed practitioner (US only). 

 
1.4 Guarantee and life cycle 

 
TensioMed Ltd. offers a 2-year warranty for a brand-new device. Any repair and device calibration 
within or beyond the warranty period are performed by TensioMed Ltd. in the service station of the 
company (Kossuth Lajos Street 97. Budapest H-1181). The service life of the device is 8 years, and its 
shelf life is 10 years. 
 
The instrument does not require regular maintenance during use. However, it is recommended that 
the instrument be sent to the service station of the manufacturer (TensioMed Ltd.) every 18-24 
months for calibration and every 3 years for examination. 
 
Warning! The procedures described above can only be performed by the manufacturer! If the 
operation of the device is faulty in any way, or it is due for supervision, please contact our customer 
service (contact information below). We ask you to not try repairing the device or have it repaired at 
any other service station! 
 
Central office and service: 
 
TensioMed Ltd. 
Kossuth Lajos Street 97.   
Budapest H-1181 
Hungary 
Phone:  (+36) 70 886 7337 

(+36) 70 315 6197 
Web:  www.tensiomed.com 
E-mail:  info@tensiomed.com  

mailto:info@tensiomed.com
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1.5 Warnings and precautions 

 

!  Caution! 

Patient safety 

The device has an integrated safety mechanism, which prevents the cuff pressure to exceed 
300 mmHg. If, however, the inflation continues above this value or the pressurization lasts too 
long, unplug the tube of the cuff from the device and remove the cuff from the subject! 

Too frequent or too long pressurization by the cuff can cause blood flow interference. Ensure 
that measurements do not result in prolonged impairment of blood circulation in the patient’s 
limb!  

Ensure that the cuff tube is not kinked during measurement as it may cause prolonged 
pressurization of the patient’s limb. 

Do not use the device on an arm, which is being injected with intravenous injection. 

Do not use the cuff on burned, irritated or injured skin. 

Do not use the device on patients suffering from coagulation disorders, because the 
compression of the arm by the cuff may cause suffusion.  

If a patient has previously undergone a vascular surgery (such as a shunt between the artery 
and the vein) and / or a permanent or temporary cannula has been inserted into the vein, or 
into the artery, for the administration of intravenous drug, do not place the blood pressure 
cuff on this arm, but perform the measurement on the other (intact) arm. 

If an extensive mastectomy operation was performed before on a patient on one of the sides 
of their body, do not install the cuff on the arm on that side! 

Do not use the device on neonates or infants! No measurement shall be performed on 
persons below 3 years of age! 

In case of an active skin disorder affecting the arm, or in case of any inflammation type or any 
wound existing on the arm, please use the intact arm for the measurement. To detect these 
cases, the patient should be asked before the examination, or the arm should be inspected. If 
both arms are affected, it is the physician’s responsibility to decide whether the value of the 
data provided by the proposed diagnostic procedure is proportional to the risk that may be 
caused by the damage that may occur during the diagnostic procedure. 

 
Device use 

The user of the Arteriograph instrument is expected to be able to read, understand and learn 
the contents of the user manual. When using the software, it is also an expectation to see and 
understand the messages and inscriptions of the software. Further minimum requirements for 
the user (operator): be able to install the cuff properly (tight), to measure the distance 
between the recess of the upper edge of the sternum and the upper edge of the pubic bone, 
and the arm circumference with a measuring tape, and to operate the computer program. For 
the proper execution of the Arteriograph measurement, there is no need for special and / or 
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educational qualifications. 

Note, however: the assessment of the measurement results provided by Arteriograph and the 
determination of the necessary diagnostic/therapeutic steps, will be the responsibility of a 
physician or a specially trained assistant with a higher education degree. 

Only use with cuffs supplied by TensioMed Ltd! Use of cuffs supplied by a third party can lead 
to erroneous measurement results. 

Confirm the results of the blood pressure measurement with an auscultation method if any 
significant error in the obtained values is suspected. 

Do not use a microwave device (e.g. mobile phone) near the unit during measurement. 

Any measurement performed with the device when it is exposed to mechanical vibration (e.g. 
in vehicles) will have unreliable results. 

Prevent the device and its accessories to be exposed to direct sunlight, to get in contact with 
any liquid or from excessive mechanical impact. 

Extreme temperatures, humidity, and altitude can affect instrument performance. 

Pressurization of the cuff may temporarily cause loss of function of simultaneously used 
medical electrical equipment on the same limb. 

The device cannot be repaired during use. Disassembly or modification of the device is not 
permitted! Please refer to section 1.4. The manufacturer does not accept any liability for 
damage or malfunction in the event of non-compliance. 
 
Do not connect the device to a computer network, use it only with the computer you installed 
the user software on! Else an „Access violation” error may occur. 

 
 

Restrictions of use 

The device cannot be used in case of atrial fibrillation and other forms of severe arrhythmia 
(more than 2 ectopic beats during the suprasystolic operation) or in case of severe tremor 
(e.g. Parkinson disease). The less severe forms of arrythmia do no influence the accuracy of 
the device. 

Do not use in presence of tremor as results may be inaccurate. 
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2. Figure 

2. The Arteriograph device 

 
This section will give an introduction on the device along with installation information and 
operation instructions. For detailed specification please see Section 7. 

2.1 The device at a glance 

 
Figure 1. shows the front view of the device: 

 
1. The name of the Device 
2. Air connector 
3. LCD  
4. Push button for entering 

two commands to control 
the device, as per Section 
2.4  

5. Symbols standing for the 
above two commands 

 
Figure 2. shows the device label. The meanings of the symbols are the following: 

6. Name of the device  

7. Name of the manufacturer 

8. Range of ambient operating temperature 

9. Manufacturing serial number 

10. Applicable nominal range of supply voltage with the batteries  

11. Year of manufacturing 

12. Safety classification of electric shock protection (Classification: Patient side: BF) 

13. Warning on the importance of reading this User Manual thoroughly 

14. Certification mark as a guarantee of the device’s conformity to EU requirements 

15. Version ID of the device 

16. Headquarters of the manufacturer 

17. Any equipment permanently removed from use shall be disposed of in a selective manner to 

provide proper reuse and recycling and reduce any harmful effects on human health and the 

environment 

18. Level of protection against any liquid or grainy material leaking into the device (IP N1N2) 

N1=2: Protected against solid foreign objects of 12,5mm and greater 

N2=0: Not protected against water 
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2.2 The accessories of the device 

 
Arteriograph has the following accessories: 
 

• Three cuffs of different sizes (see below) 

• Arteriograph software installation CD and flash drive with the instruction for use 

• Instruction for use 
 
The cuff is the Applied Part (AP) of the device that necessarily comes into physical contact with the 
patient during the intended use of the device to perform its function (see section 5.3 for more 
information). 
 
The cuff sizes are as follows: 
 

Cuff type 
Cuff dimensions 

Arm circumference 
range 

Cuff: S 42,5 × 10 cm 20 – 24 cm 

Cuff: M 55 × 14 cm 24 – 32 cm 

Cuff: L 65 x 14 cm 32 – 38 cm 

 
The manufacturer of the cuffs: 
 

Vistar Medical Supplies Co., Ltd. 
8th Floor, Hanhaida Building, No. 7 Songgang Blvd.  
Shenzhen, 518105 China 

2.3 Preparing the device 

Arteriograph is a battery-operated device. 

• Insert 4 durable alkaline AA batteries into the device while taking care of the right polarity 

(see Figure 3.) 

 

 

 

Attention! If you do not intend to use the device for a longer time (more than 1 day), 
remove the batteries and store them in a dry and cool place out of little children’s 
reach. Do not expose them to intense heat because it may cause a short circuit. 
Regarding the alkaline batteries, the policies of use and waste collection as governed 
by detailed environmental and labour safety requirements are to be considered. 

 
Once the batteries are inserted in the device, the following checks are performed automatically: 

Note: The clock circuits of the device are supplied by a built-in Lithium CR2032 battery, therefore 
the operation of the clock is independent from the AA battery supply. 

Figure 3. 
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• Voltage control of the batteries. The measured value appears on the 
LCD for a few seconds. The supply voltage is sufficient if the 
measured value is between 6.0 V and 5.4 V. 

 

 

5.6V 

 

• If the voltage drops below 4.4V, the batteries must be replaced. A 
warning symbol of low battery appears on the LCD. 

 

 

LOW BATT 

 

• The device is ready for operation if the current PC time appears on 
the LCD.  

 

 

  09‐39 

 
 

2.4 Operation instructions 

 
There is a single push button available for operating the device (Section 2.1). The user can use the 
only push button for issuing a total of two commands. 
 

1. By pressing the button once, a manual blood pressure measurement will start.  
Note! In this case the device performs blood pressure measurement without any arterial 
function (e.g. PWVao, Aix) evaluation. 

 
2. The device can be turned off by pressing the button twice. In OFF 

state the device cannot be operated either manually or by PC. To 
turn it on, the button must be pressed twice again. 

 

 OFF 
 

 

 

2.5. System (Bluetooth communication) setup 

 
Your computer must have active Bluetooth connection capability. The Bluetooth icon appears in the 
system tray of your PC indicating an active Bluetooth service. For connecting Arteriograph to the PC 
see Section 5.2. Data transmission can only be performed with the Arteriograph software. 
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3. The software 

3.1. Arteriograph software installation and setup 

3.1.1 Preliminary information about the software 

 
The Arteriograph software is a Windows-based software. The common Windows mouse functions 
are applied in the program (left single-click, double click, drag, etc.). 
 
Button and command names ending in “…” indicate that a dialog window will open upon clicking on 
those items. 
 
Arteriograph software allows you to perform arterial function measurement, to print and share the 
measurement report, and to modify the measurement settings. 
 
 

3.1.2 Minimum system requirements 

 

• Minimum configuration: Intel Pentium PC, 2GB memory, 3GB available HDD capacity, 

minimum 1024*768 screen resolution, maximum 1920*1080 screen resolution 

• Windows 10 or 11 installed, 

• Active Bluetooth v2.0 port. 

 

Although the program can start in a less powerful environment, in that case we cannot take 
responsibility for its fast and reliable operation. 
 
3.1.2.1. Recommended system screen resolutions 

 

• 1024*768; 1152*864; 1280*768; 1280*800; 1280*960; 1280*1024; 1360*768; 1366*768; 
1400*1050; 1440*900; 1600*900; 1680*1050; 1920*1080 
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3.1.3 Software Installation 
 
For installing the Arteriograph software on the computer, the user must have administrator 
privileges. 

 
Step 1 Insert the CD into the CD tray of your PC or use the provided flash drive. The 

installation procedure will start automatically. In case it does not, start the 
installation by double-clicking the setup.exe file on the disc or flash drive with use of 
a file manager program. 
Should a security warning pop up, simply press Yes to start the installation  
 

 
 

 
Step 2 

 
To start the Setup Wizard, choose a preferred language (English is recommended) for 
installation and click OK. 
 

 
 

 

Step 3 
 

Select the mode of installation from the drop-down list. This can either be Full 
installation or Upgrade. For the first time, select Full installation. 
When the preferred method is selected, click Next. 
Note: if Full installation is selected on a computer which already contains an 
Arteriograph database, that database may be lost! 
 

 
 
 

 

 

Step 4 
 

The following screen offers you to create an icon on the desktop. This task can be 
deselected. Click Next to start the installation process. 
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Step 5 
 

The status of the automatic installation procedure can be tracked on a progress bar. 
If you want to interrupt it, click Cancel. 
 

 
 

 

Step 6 
 

When the automatic installation procedure is completed, the following screen 
appears. Click Finish to exit the Wizard and start the Arteriograph software.  
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3.2 The software at a glance 

 
To start the Program, double-click the Arteriograph icon on your desktop, or use the 
Windows Start Menu to navigate to the Arteriograph program. 
  

 
A splash screen appears along with a login dialog window.  
When you run the software for the first time, simply press OK and the program is initiated with the 
default “ARTERIOGRAM” login name. On every login after that, however, the username can be 
specified. 
 
  

 
 

 
The program window appears with the following components. (For a better understanding, the 
picture below shows the program window in the state of a completed measurement.) 
 

1. Menu bar 

2. Toolbar 

3. List of examinations  

4. The primary results tab 

5. Patient details header 

6. Real-time data display 
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3.2.1 The menu of the program 

 
The menu bar of the software can be found under the title bar and contains the menu items which 
provide access to all the major functions of the program. 
 
The File menu 
 

 

The File menu allows entering new patient data; opening, editing or 
deleting existing records; saving the result of an analysis; furthermore, 
editing, printing and sending medical reports, as well as exiting the 
program. 
  

 
The View menu  
 

 

The View menu enables the choice to either display the pulse wave 
records or the maximum amplitudes of the oscillatory signals at each 
cuff pressure step (deflated stepwise with 10 mmHg) during a blood 
pressure measurement. Furthermore, you can set both the horizontal 
and the vertical scale, hide the Toolbar, and get information about the 
chosen patient. 
 

 

  

1 

2 

3 

4 

5 

6 
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The Tools menu 
 

 

The Tools menu provides the functions to start automatic pulse wave 
data collection processes with the help of the connected Arteriograph 
device or interrupt an ongoing data collection process. Previous 
versions of databases can be converted and imported into the new 
database format. Furthermore, exports and backups of the actual 
database can be created. All the program and device settings can also 
be accessed and modified through this menu. 
 

 

 
The Information menu 
 

 

General information about the manufacturer and the software are 
available in the Information menu. This menu also includes the present 
Instruction for use (User’s manual).  
 

3.2.2 The Toolbar of the program 
 

The Toolbar can be found under the menu bar. The displayed icons on this segment provide the 
means to use the major functions of the product.  The Toolbar can be displayed or hidden by the 
Toolbar command of the View menu. 
 

3.2.3 The list of examinations 

 
All the previous – if there are any – examination records of the selected patient are listed here, 
sorted by the date and time of recording. If a note is created by the operator for a specific 
measurement sequence, the software will display the following icon next to the measurement date 
and time: 
 

 
 

3.2.4 The primary results tab  

 
The calculated hemodynamic parameters are displayed here when an analysis of measurement data 
is performed (automatically or manually). 

 

3.2.5 Patient details header 

 
The name and date of birth of the patient are displayed on this header. 
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3.2.6 The real-time data display 
 

After the completion of measurement, the acquired pulse pressure wave graph is depicted on this 
window in the form of non-calibrated curves (oscillations) as recorded by the device. The recorded 
and saved pulse pressure waves can be opened and displayed any time.  
The user can also select the “Amps- pressure curve” sheet which displays the peak amplitudes of the 
oscillometric curves obtained in the currently selected measurement, or the “Arterial age 
assessment” sheet, containing the estimated vascular age of the patient based on the arterial 
function assessment. 

 

 

3.3 First step – register a user 
 

If the program is used by several operators, with each having different groups of patients, users can 
access their own respective patients’ data after login. A new user will have to register in the database 
by specifying their first name, family name and user ID.  
The Arteriograph software is recommended, however, to be used with the default login name 
“ARTERIOGRAM”. 
 
Registering a new user  

 
To register a new user, open the Setup… window under the Tools menu and select the Users 
tab. To enter a new user, click on Add New and then enter the first name and family name of 
the user and specify a login name (user ID). Click Add to register the new user in the database 
or click Cancel to interrupt the registration.  
The new user can log in with their user ID after unchecking the “Enter with standard login 
name” option. 
 

 
If the operator wants to use the standard login name, the “Enter with the standard login 
name” option should be left checked and no login name should be written. 
 
Note:  

• the settings in the program (COM port number, Auto JUG-SY, etc.) have to be defined 
for each user separately! 

• the registered users’ data cannot be edited. 
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How to delete registered users 
 

To delete registered users, select Setup… under the Tools menu and click on the Users tab in 
the pop-up window. The Delete button can be used for removing a pre-selected item from 
the user list. If the list contains only one user, the Delete function will not be available. 
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4. Performing a simple blood pressure measurement 

 

4.1 Performing the Arteriograph measurement 

 
To operate Arteriograph, first prepare the device (see Section 2.3). There is a single push button 
(Section 2.1) available for two functions: 

• pressing the button once: starting a simple blood pressure measurement/ halting an already 
started blood pressure measurement. In this case no computer is needed, and the device will 
work standalone, but it will not provide any arterial function parameter results. The 
measured systolic and diastolic blood pressure values and the heart rate will appear on the 
LCD of the device. 

• pressing the button twice: switching the device on/off. 
 
 
The device is ready for operation if the current PC time appears on the 
LCD.  
 

  09:39 
 

 
If a simple blood pressure measurement starts, the current time will disappear from the display and 
then: 
 
 

• The LCD test pattern is displayed, 
 

 

 

88888888 XX X X X X X X
 

 

• The supply voltage is checked 
 

 

5.6V 
 

 

• the device calibrates itself by setting the zero pressure  

 

 CAL 0 
 

 
 
The measurement starts with the inflation of the cuff. This procedure is 
indicated by an arrowhead pointing upwards.  
 

 

X_   87 
 

 
 
During cuff deflation an arrowhead pointing downwards is depicted. 
 

 

X
_

  69 
 

 
 
When the measurement is completed, the device displays the systolic and 
diastolic blood pressure values, 
 

 

128/96 
 

 
and then the heart rate. PUL 68 



 

 
21 

TensioMed Arteriograph-02v14-00 

 

  
 
The measurement process can be halted any time by pressing the button 
once. The text “OFF” will appear and remain visible for about 5 seconds on 
the display. Thereafter the time is displayed again, which indicates that the 
device is ready for another manual or programmed measurement.  

OFF 

 
 

4.2 Acoustic signals 

 
When the device is active, a soft acoustic signal is emitted when its button is pressed down. 
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5. Performing pulse wave recording and analysis 

 
 
Pulse wave recording can only be initialised by the Arteriograph software that is running on a 
Windows operating system, using a medium with wireless Bluetooth connection to the Arteriograph 
device (in this case the button of the device is not used to start the measurement)!  
The oscillatory signals recorded during the whole measurement process are displayed real-time on 
the screen. 
 

5.1 Hemodynamic parameters measured by the Arteriograph 

 
The following hemodynamic parameters are computed during the measurement: 
 
Sys – Brachial systolic blood pressure (mmHg) 
 
Dia – Brachial diastolic blood pressure (mmHg) 
 
HR – Heart Rate (beat/min) 
 
MAP – Mean Arterial Pressure (mmHg) 
Calculated from the brachial systolic and diastolic blood pressure. 

MAP = Dia +
Sys−Dia

3
 

 
PP – Brachial Pulse Pressure (mmHg) 
PP is the difference between the systolic and diastolic blood pressure values in mmHg. 
 
ABI – Ankle – Brachial Index (dimensionless index) 
The ratio of the ankle systolic blood pressure and brachial systolic blood pressure values. 
 
Aix brachial – brachial augmentation index (%) 
Augmentation index = The difference between the amplitudes of the second (reflected) systolic wave 
(P2) and the first (direct) systolic wave (P1) over the pulse pressure (PP) and multiplied with 100  

Aix = 
𝑃2−𝑃1

𝑃𝑃
× 100 

 
Aix aortic – central augmentation index (%) 
Calculated on the basis of a very strong (R>0.9) linear correlation between the brachial and central 
augmentation index. 
 
ED – Ejection Duration of the left ventricle (ms) 
It is the period of the mechanical systole, i.e. the time interval between the beginning of the heart 
cycle and the dicrotic notch. 
 
RT – Return time (ms) 
The RT is the time of the pulse wave travelling from the aortic root to the bifurcation and back.  
 
PWVao – aortic pulse wave velocity (m/s) 
The velocity of the pulse wave propagation in the aorta. 
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This is calculated from the travelled distance (measured as the suprasternal notch – pubic bone 
distance) of the pulse wave in the aorta divided by the transit time (RT/2). It relates to the 
characteristics of the aortic wall. The stiffer the aortic wall, the higher the PWVao is. 
 
SD PWVao (m/s) 
A parameter providing information about the quality of the measurement. The PWVao is calculated 
from each recorded pulse, then the standard deviation is depicted. For more details, see Section 
5.4.4.1. 
 
SBPao – central systolic blood pressure (mmHg) 
The central systolic blood pressure (SBPao) is the pressure in the aorta, and it is considered as an 
important hemodynamic parameter. It is a result of the ejected stroke volume and the dampening 
function of large arteries and propagative and reflected pressure waves. It is lower physiologically 
than the peripheral systolic blood pressure, which is due to different wall structures. 
 
PPao – central pulse pressure (mmHg) 
The difference between aortic systolic and aortic diastolic blood pressure values. 
 
DRA - Diastolic Reflection Area (dimensionless index) 
The DRA provides information on the quality of the left coronary filling conditions during diastole. 
This parameter is partly based on the duration of the diastole, and on the other hand on the area 
difference, calculated without wave reflection in the diastole (theoretical, mathematically calculated) 
and the actual recorded pressure at the diastole with diastolic wave reflection. I.e., the theoretical 
diastolic pulse pressure waveform without reflection is subtracted from the recorded diastolic pulse 
pressure waveform. (See Section 5.4.5.) 
 

 
 

 

• SAI – Systolic Area Index (%) 
SAI is the systolic part of the area under the entire pulse curve. 

 

• DAI – Diastolic Area Index (%) 
DAI is the diastolic part of the area under the entire pulse curve. 

 
Pressurising the cuff to the diastolic blood pressure volumetric signals can be obtained. The area 
under the curve is taken as 100%, and then it is divided into systolic (SAI) and diastolic (DAI) area and 
expressed as the percentage of the total (100%).  
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5.2 System setup 
 

After installation, connect Arteriograph to your medium (e.g., computer) by following the 
instructions of the enclosed Bluetooth Operation manual.  
If during the Bluetooth connection process, a password is required, write 0000.  
The device should not be farther than 5 metres from the PC for optimal operation.  
 

!  

Attention! Transmission-blocking objects (e.g. metal objects) can cause signal 
weakening and consequently malfunction in the communication. The use of the 
supplied protective pouch does not affect the transmission signal strength, however. 

 
When an active Bluetooth device (e.g. a PC) tries to pair with Arteriograph, the 
sign shown on the right appears on the Arteriograph’s LCD. At this point, no 
actual data transmission takes place yet.  

 

BLUELINK 
 

Data transfer can only be initiated with use of the Arteriograph software. 
 

5.3 Patient preparation 

 
We have extensive experience with the application of Arteriograph in the 3-90 age group, as our 
database of tens of thousands of patients has shown that the measurement can be performed in 
such a wide age range. 
 
There is no direct restriction on the weight of the patients, because if the cuff can be placed on the 
upper arm in the prescribed manner, and the device is able to collect signals with an adequate 
quality for evaluation, the examination can be carried out without any problems. Examinations on 
extremely overweight patients (mostly on the arm) may provide proper results only if the cuff can be 
placed in a correct way on their upper arm.  
 
There is no specific height limit for the examination with the instrument. 
 
There are no functional obstacles regarding the continuous repetition of Arteriograph 
measurements, even at time intervals of 2-3 minutes. However, the operator should carefully 
consider that the patient is unavoidably burdened by a degree of inconvenience in case of 
performing multiple measurements. Therefore, the value of the information obtained from the series 
of measurements should be more significant than the above-mentioned side-effect on the patient. 
 
Our studies so far show that a single measurement with the proper preparations detailed in this 
section is sufficient to judge the patient's cardiovascular prognosis during screening tests. However, 
taking the average of 3 consecutive measurements results in greater reliability. 
 
Wrap the cuff preferably around the right upper arm. When doing this procedure, please consider 

the following: 

• Use the cuff size suggested by the software (see Section 5.4.2.4.) 

• Make sure that the cuff is tightened properly, without causing harm to the patient. The cuff 
should fit the patient’s arm evenly. The tightness is sufficient if your finger cannot be 
inserted easily under the cuff. The patient should wear clothing that can be easily adjusted or 
removed to enable application of the pressure cuff to the arm. 

• Make sure that the patient’s skin is not pinched by the cuff. 
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According to the guidelines for measuring arterial function routinely the supine position is 
recommended for measurements. In case the examination is performed while the patient is seated, 
indicate this fact in the “Comment” field of the software when the patient’s data are entered. The 
patient in this case shall sit comfortably, with both feet flat on the ground, with their arms and back 
supported, and not crossing their legs. Although there were no significant differences between 
PWVao and Aix in the sitting and lying position regarding the values of these parameters (Hypertens 
Res. 2011 Feb; 34 (2): 202-8), we recommend a supine position during the Arteriograph examination, 
because it is more stable from a hemodynamical perspective. 
 

 

• Place the cuff in a way that the hose is in anterior position and the “ART” (artery) signal on 
the cuff should look medially, where the brachial artery is located. 

• To avoid the irritation of the skin a long-sleeved shirt made of some thin material can be 
worn under the cuff. 

• Lead the hose of the cuff to the device while ensuring that it isn’t compressed or kinked.  

• Connect the air connector of the hose to the one on the device. For this, push them together, 
then twist the plug slightly until it securely clicks. Make sure that the cuff is properly 
attached by checking the tightness of the connection. 

• Measure the suprasternal notch – pubic bone distance (Jug-Sy) with the supplied tape 
measure. 

 
 

 

 

Note: If the cuff is too loose or big, the software may not provide proper measurement results 
and may display an error message (“Small amplitudes!”). 
The cuff should not contact the patient’s chest during the measurement because the respiratory 
movements may cause pressure alterations and artefacts. 

Note: The suprasternal notch (jugulum) – pubic bone (symphysis) distance should be measured in 
a straight line. Measuring on the body surface can lead to overestimation (e.g., in case of obese 
patients). 

Note: The Arteriograph software can estimate the Jug-Sy distance based on the height of the 
patient. If you want to use this function, tick the “Auto JUG-SY” checkbox in Tools/Setup before 
adding a new patient, and provide their height then.  
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• Ensure optimal measuring conditions: 
o Speaking, muscle movements, especially the movement of arm muscles must be avoided 

as these activities may significantly increase the measurement time, result in 
measurement failure, or reduce its precision rate. Sudden muscle movements (tremor) 
distort the shape of the measured pulse wave and render its evaluation impossible. 

o Within 3 hours before the examination the patient should not consume a greater 
amount of food, drink coffee/tea or smoke. However, the patient should not be 
measured in fasting condition, either. A light meal is suggested 3 hours before 
examination. Drinking enough water is also very important (at least 1 liter in the last two 
hours before the measurement). Please, empty the bladder. Additionally, within 12 
hours before the examination alcohol consumption should be avoided.  

o The patient should take all medication prescribed to them 3 hours before the 
measurement and inform the operator of Arteriograph about the types and required 
doses of the medications. 

o The patient should not sleep during the measuring phase. 
o At least a ten-minute period of physical and mental rest is required before the 

examination. 
o Any circumstance (e.g. noise, phone ringing, persons’ movement in the examining room) 

that may disturb the patient’s calm must be avoided. 
o Should “White Coat Effect” be detected, the measurement must be repeated several 

times with intervals of a few minutes, or the examination should be repeated another 
time. 

 
The measurement can be carried out wherever the requirements detailed above are met. The 
Arteriograph measurement and the evaluation of the obtained parameters can be done in separate 
locations and at a different time. 

5.4 Performing the measurement 

 
To start the Program, double-click the Arteriograph icon on the desktop or use the Windows Start 
Menu to navigate to the program. Log in to the software with the previously specified username (see 
Section 3.3). When started for the first time, the program logs in the user with the default 
“ARTERIOGRAM” login name.  

 
If a wrong or non-existent username is given, the program will prompt to login with the default one. 
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5.4.1 Device and measurement setup 

 
Before starting the measurement, changing or checking setup parameters may be necessary. 
 
For setting up the device, select Setup… under the Tools menu. 
 

 
 
In the pop-up window the following parameters can be set on the System tab: 
 

• Initial inflation pressure is the value Arteriograph inflates the cuff to when starting a blood 

pressure measurement. This can be set as a fixed or a relative value. During the second 

measurement the device adds 50 mmHg to the mean arterial pressure (MAP) value 

measured previously and inflates the cuff to this pressure. The relative value is the default 

setting. 

• Offset of systolic pressure level determines the value which is added to the measured 

systolic pressure at the final stage of the measurement, in order to obtain the suprasystolic 

pressure step where the device will record pulse wave data. 35mmHg is the default setting, 

which means that data will be collected at a pressure level of the measured systolic value + 

35mmHg. For diagnostic examinations this value should not be set lower than 35 mmHg and 

it is recommended to be set to 45 mmHg to detect the reflected systolic wave more reliably. 

• Offset of diastolic pressure level determines the value which is added to the measured 

diastolic pressure to obtain the pressure step where the device will record diastolic pulse 

wave data (volume curve). Zero (0) is the default setting, which means that data will be 

collected at the pressure step corresponding to the measured diastolic value. Diagnostic 

examinations should not deviate from this value. 

• Data transfer time at dia (diastolic) and sys (systolic) pressure level determines the 

timespan (in seconds) of pulse wave data collection at the above-specified pressure levels. 

The default value is 8 seconds. Diagnostic examinations may deviate from this value in the 7-

10 seconds range. 

• Communication interface GDT; The GDT interface enables data transfer between medical 

devices and the clinic's IT system, based on the standards of the German Quality Assurance 
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Software (QMS). In order to communicate, there is a need for a GDT-supporting clinic 

software system. To configure the GDT interface, please read carefully and follow the 

instructions in the GDT Interface Manual on the Arteriograph Installation CD. If the "AUTO 

PDF" function is selected, the GDT communication automatically saves the test report in pdf 

format in a directory called PDF. 

• Enter the database path; The default database path for the software database is "C: 

\ProgramData\Tensiomed\Arteriograph", where the "Database" and "Language" libraries 

contain the required data files. It is also possible to select another directory, but it is 

necessary to copy the "Database" and "Language" libraries, with their full contents, from the 

default location to the new path. 

• Specify the path of the PDF library; If you select "AUTO PDF", you can select an arbitrary – 

but writable - directory path where the software can automatically save the test report in a 

pdf format. 

• Calculation of Ankle Brachial Index; if selected, the Ankle-Brachial Index is calculated. For 

this, the ankle systolic blood pressure has to be measured before or after the pulse wave 

recording (see Section 5.4.3).  

• Communication port; A default communication port number can be defined here. This way 

the user can avoid the more time-consuming process of the automatic port search, which 

may take 20-30 seconds. The proper port number can be checked under Control Panel -> 

Bluetooth devices -> More Bluetooth settings -> COM ports tab -> Outgoing port number. 

The program will save the set port number until only one device is used. 

• Auto JUG-SY function; by selecting this function there is no need to measure the patient's 

jugulum - symphysis distance. The software will automatically calculate it based on the 

patient’s height, using a large database. 

 
 

• User-defined parameter; One new parameter can be added to the patient’s dataset through 

this function. Enter the name of the parameter into the input field (the parameter will be 

displayed in the Patient details field on the print-out, see 5.4.6.2) and press Set.  

 
Non-device-specific settings: 
 

• Program language: the language of the Arteriograph software can be selected. The change 

only takes place upon the next program launch. 

• Date format: one of the following date formats can be selected: year-month-day, day-

month-year, and month-day-year. 

Note: The name of the new parameter can be added to a patient’s data only once and 
cannot be modified or deleted later. This parameter will belong to the registered patient 
data, and it will not be measured by the device, but the value can be modified by the 
operator. 

Note: The Auto JUG-SY function should not be used on patients from the Far East 
population (Chinese, Japanese, etc.). In this case the PWV value is not calculated properly, 
and only the Return Time (RT) is accurate. 
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The default settings can be restored by clicking on Set default. The settings must be downloaded into 
the device to take effect. For this, use the Download to the device button.  
 
The download of the settings to the device can be tracked on the screen. The 
text “CONNECT” will be displayed on the LCD of the device while 
communication is in progress. 

CONNECT 

 
Successful data download will be confirmed on the PC. 
 

 

5.4.2 Select a patient 

 

5.4.2.1 How to select an existing patient 
 

After login to the program, use the Open command in the File menu or click on the Open 
button (see on the left) on the toolbar for displaying the list of the patients that belong to 

the current user. Find and select the patient you are interested in (by double-clicking on the row 
which contains the patient’s details or by highlighting the row with a single click and then click on 
OK).  
 

 
 

The selected patient’s full name and date of birth are displayed in the Patient Details block under the 
Toolbar. In addition, the patient’s previous examinations will also appear in a list, if there are any. 
 

 
 

5.4.2.2 How to modify a patient’s data 
 
Select the patient (as described above) whose data you wish to modify (by a single click in the Patient 
list) and press Edit. Click on OK to save the modified data. 

 
 
5.4.2.3 How to search for a patient 
 
The search function of the software is helpful to find a single patient even in larger databases.  

Note: The downloaded settings into the device cannot be cancelled. They can be overwritten by 
downloading new settings at any time, however. 
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For a quick search click anywhere in the patient list and start typing the required family name. The 
quick search is not case-sensitive. 
An advanced search can be performed by name, date of birth or ID with the help of the “Search by” 
function. Select “Name”, “Date of Birth” or “ID” and type in the name, date, or ID you want to find 
into the “Search for” field. This function is case-sensitive. When searching by name, the search is 
made in both the first and last names and even a part of the name can be searched. 
 

5.4.2.4 How to enter a new patient’s data 
 

If you want to add the data of a new patient into the database, select the New patient 
command in the File menu or click on the New patient button (see on the left) on the Toolbar. 

For registering a new patient, only the ID, family name, first name, date of birth, the height, the 
patient’s jugulum – symphysis (JUG-SY) distance and the upper arm circumference are required to be 
filled out (those with a yellow background). The jugulum – symphysis distance and the upper arm 
circumference can be measured with the tape measure provided as an accessory (see Section 5.3). 
The first data is necessary for calculating the pulse wave velocity while the second one is needed for 
calculating the proper cuff size. After filling out the arm circumference field, the suggested cuff type 
and its size will automatically appear next to it.  
 

 
The cholesterol unit can be selected from a drop-down list (mmol/l or mg/dl). 
The Comment field is advised to be filled out with important information about the patient or the 
measuring conditions (e.g. the measuring position, pregnancy). 
Fill out the Risk profile field with information on the known cardiovascular risk factors, such as 
medical history (anamnesis), duration and frequency of smoking, etc. 
 

 
 
 

Note: To achieve a proper measurement quality, always use the cuff suggested by the software.  

Note: If the Auto JUG-SY function is activated, the JUG-SY setting will not be displayed on the 
New patient window.   
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5.4.3 Medical examination with Arteriograph 

 
To start a single measurement, select PW read under Tools or press the START 
button on the toolbar.  

 
To start a scheduled sequence of measurements, click on the Repeated 
Measurements… button on the toolbar. The length of the test and the measurement 

frequency can be set on the dialog box. To start the measurements, click Start. The measurement 
process can be interrupted by pressing the Stop button. 
 

 
 
After starting a measurement, a confirmation window will pop up with some important information. 
If they are correct, press Yes to start the measurement process. If these data need to be modified, 
press No and edit the patient characteristics (see Section 5.4.2.2.). 
 

 
 
The measurement process starts with the software connecting to the Arteriograph device. First the 
discovery of the device and active ports, and then the communication process can be tracked on the 
screen. While this communication is in progress, “CONNECT” (See Section 5.4.1) will appear on the 
LCD of the device.  
 

 
 
After a short time, the measurement will start automatically by performing a blood pressure 
measurement in the first phase. During measurement, the recorded pulse wave curves can be 
observed on the screen.  
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In the second phase, the pulse wave recording for the hemodynamic analysis of diastolic function is 
performed. 

• the device will inflate to the diastolic pressure level and record the pulse waves for a 
previously determined duration (8 seconds by default).  

In the third phase, the device inflates further to the suprasystolic pressure level (by default to the 
measured systolic value + 35 mmHg), occluding the brachial artery completely, and records the pulse 
waves for a previously determined duration (8 seconds by default).  
(The time and pressure offset values can be modified through the system settings function in the 
above-described manner. See Section 5.4.1) 
 
During the measurement there is a real-time data transfer, enabling the user to see the recorded 
oscillatory waves on the screen. At the end of the examination, the device transmits the blood 
pressure values to the medium (eg., computer) as well. The software displays the following: systolic 
and diastolic blood pressure values, heart rate, MAP, pulse pressure, and the entire recorded pulse 
wave curve.  
 

If you want to interrupt the measurement, use the Abort command. An 
Abort button appears automatically next to the “PW” button when starting 

a measurement, and the same command can be found under the Tools menu. Please note that this 
function only halts the data collection procedure of the software and does not affect the operation of 
the device. To interrupt a measurement on the device, the push button of the Arteriograph shall be 
pressed once instead. 

 
If the Calculation of Ankle – Brachial Index (ABI) was selected (See Section 5.4.1), a dialog window 
appears when the suprasystolic pulse wave recording phase is completed. Enter the measured ankle 
systolic blood pressure here and press OK. The calculated value will appear under the blood pressure 
values in the Primary results tab (see Section 3.2.4). If calculation of ABI is not needed, or the ankle 
blood pressure could not be measured, press Cancel.  
Measurement of the ankle blood pressure is advised to be performed before the pulse wave 
recording. For measuring systolic blood pressure on the ankle, the Doppler technique is suggested. 
However, if it is not available, the blood pressure measurement can also be performed on the ankle 
with Arteriograph, using the simple blood pressure measurement function (see Section 4). In the 
latter case please use the appropriate cuff size (the same rules apply as for arm cuffs, see Section 
4.1).  

 
When the measurement is completed, the calculated blood pressure and arterial function data will 
be presented in the Primary results tab (see Section 3.2.4.), while the recorded pulse wave curves are 
depicted on the real-time data display (see Section 3.2). 
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Every examination is saved automatically. A stored examination can be deleted by selecting the row, 
which contains its date and time in the Examinations list and then pressing the Delete button on the 
keyboard. 

5.4.4 Quality control of the measurement 

Movements, arrhythmia, respiration, etc. with a disturbing effect on the measuring process may 
distort the shape of the recorded pulse wave, which may result in false hemodynamic parameter 
values. Having finished the measurement, its quality should be checked to decide whether the result 
of the analysis can be accepted.  
We would like to note that the device and the software are sensitive to the of the input signal 
shapes’ appropriateness. If the software detects artefacts in the signals, it purposely does not 
provide arterial function parameters.  
In case of any measurement with a standard deviation higher than 0.7, you can simply mark those 
pressure waves that are the most identical in a single measurement and the result will be average of 
selected similar waves which reduces deviation of obtained data. For this reason, please follow the 
instructions given below. 

1. Select the problematic measurement with the high standard deviation. 
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Choose three or more measured waves which shows similarity in shape by simply clicking and 
dragging the mouse from beginning till the end of mentioned waves. The average pulse wave velocity 
will appear in which the high deviation due to probable operating issues are avoided. 
 

 
 

Thus, the accuracy and reliability of the measurements can be significantly increased. As a result, the 
repeatability (variance) of the PWVao measurement results (the difference between successive 
measurements for a patient) showed the lowest variance, i.e. the most favourable repeatability in 
comparison with other instruments (J Hypertens, 2008, 26: 523-528). 
 
5.4.4.1 Quality control index: the SD PWVao 

 
SD PWVao (see Section 5.1) is the standard deviation of the PWVao values calculated using the pulse 
waves that are analysable by the algorithm of the software. This variable shows how much the 
PWVao data of each analysed pulse curve differ, therefore reflects on the identity of the recorded 
pulse wave forms. Large deviation of the measured data shows some disturbance in the 
measurement. 
 
Normal SD 
 

 

If the SD PWVao is greater than or equal to 0 and less than or equal to 0.7 
m/s, the measurement is of good quality. 
 

Borderline SD 
If the SD PWVao is higher than 0.7 m/s, but less than 1.0 m/s, the quality of 
the measurement can only be accepted with concerns. Experienced users can 
use the manual evaluation to search for appropriate waves on the 
suprasystolic part of the measurement (see 5.4.4.). If the manual evaluation 
would not provide better (<0.7 m/s) SD, the measurement should be 
repeated! 
 

High SD 
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If the SD PWVao (SD) is greater than 1.0 m/s, the measurement is considered 
to be of unacceptable quality and the results of the current analysis should be 
rejected. The SD appears in red colour in the Primary results tab to warn the 
User about the quality problem.  
 
No SD 
 

 

If the automatic analysis calculated arterial function data but no SD PWVao, 
then only one evaluable pulse curve could be found in the suprasystolic 
measurement sequence. The SD appears in red colour in the Primary results 
tab to warn the user about the quality problem. The results of the analysis 
should be rejected, and consequently, the measurement should be repeated. 
 
5.4.4.2 Quality control by visual inspection 

 
Although the SD PWVao performs considerably well in detecting erroneous measurements, further 
visual inspection can help categorizing the type of the error. Consequently, it can be avoided when 
repeating the measurement. Disturbances can also be detected by visual inspection in the case of 
measurements that were categorized to be of good quality by the SD PWVao parameter. 
 
If there is no second systolic wave on the pressure curves recorded on the suprasystolic section 
 
Arteriograph can only provide arterial function data when the first (direct) and second (reflected) 
systolic waves can be detected separately on the pressure curves recorded at the suprasystolic cuff 
pressure. If these waves are not distinguishable on the suprasystolic pulse curves, the common 
reasons are the following:  

• the cuff is too large or loosely fixed,  

• high heart rate (> 90 / min) or low amplitude reflected systolic wave (quite common at young 
age), 

• dehydrated state resulting in reduced circulating blood volume. 
 
Recognition: non-identifiable reflected waves on the suprasystolic pressure curves 

In this case the direct and reflected systolic waves cannot be differentiated on the pulse 
waveform which is always indicated by the software with a warning message. 

How to avoid: See Section 5.3. Additionally, the solution could be to use a smaller cuff or tighten 
the cuff according to the instructions. 

 
Arrhythmia 

 
The oscillatory measurement method is highly affected by arrhythmia. In such cases the beat-to-
beat variance of the pulse wave forms renders the analysis inaccurate. 

How to recognize: the heart beats do not show regularity. 
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How to avoid: this condition cannot be affected by the examiner. The SD improvement steps (see 
Section 5.4.4.) can help to find an appropriate sequence in the suprasystolic measurement phase. 

 

 
Tremor or mechanical vibration 

 
Tremor introduces an unwanted high frequency noise into the measurement. This often leads to 
nonevaluable waveforms. 

How to recognize: the measurement is noisy; a sawtooth signal is superimposed on the pulse 
waves. 

How to avoid: tremor cannot be affected by the examiner. Make sure, however that the patient 
is isolated from external mechanical vibration (e.g. do not place the patient’s arm onto a 
vibrating machine, like a PC). 
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Movement artefacts 
 

Movement artefacts distort the waveforms and lead either to not analysable measurements or 
to results with inflated variation.  

How to recognize: the baseline of the recording undulates, or some pulse waves noticeably differ 
from the others. 

How to avoid: emphatically ask the patient not to move. Manual evaluation (see Section 5.4.5) 
can help to find a regular sequence in the suprasystolic measurement phase. 

 

5.4.5 How to analyse the data 

 
Select a patient and one of their examinations you intend to analyse. You have two evaluation 
options available: automatic and manual.  
 

 
 
The automatic analysis is fast and convenient. Automatic evaluation will take place immediately after 
a patient’s examination is selected. The same function can be achieved by clicking first on Automatic 
analysis S35 (for suprasystolic data) and then on button D (for diastolic data) after the results have 
been displayed. Most of the hemodynamic parameters described above (Section 5.1) will appear in 
the results window, under the list of examinations.  During the automatic analysis the algorithm will 
analyse pulse waves of several heartbeats and calculate the mean of the results as well as the 
standard deviation of the PWVao (SD PWVao). However, if there is only one evaluable pulse wave, no 
SD PWVao can be calculated.  
 
For manual evaluation you have to go to the end of the whole measurement sequence by using the 
horizontal scroll bar at the bottom of the real-time data display. (The pulse wave curves recorded at 
the suprasystolic pressure step are depicted at the end of the measurement sequence.) You can use 
the mouse for selecting any (or several) pulse wave recorded at the diastolic and suprasystolic 
pressure steps arbitrarily.  Curves can be selected even from the waveforms recorded in the blood 
pressure measuring phase, but only those which were recorded above the measured systole or in a 
±10 mmHg range of the measured diastole.  
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To select a series of pulse waves (or a single one) highlight (hold down the left mouse button while 
moving the mouse) those from the beginning to the end of the sequence. Only complete heart cycles 
are considered in the analysis (see the picture below). 

 

 
 

• If the pulse wave of a single heartbeat is highlighted – of either those that were registered at 
the suprasystolic or those registered at the diastolic pressure level – it will be magnified on 
the secondary data display. (Please note that in this case SD PWVao cannot be calculated.) 

 
The above-mentioned separate window displays two kinds of content: 
 

o The highlighted pulse wave at the suprasystolic pressure phase is depicted using a 

green curve. There are four markers shown on the curve, the meaning of those can 

be found below. 

▪ P1: direct systolic peak value 

▪ P2: reflected systolic peak value 

▪ RT: return time 

▪ ED: ejection duration 

Blank blue circles represent the direct and reflected wave peaks and the ejection duration 
(Dicrotic notch), respectively. The filled red dot represents the calculated return time. The 
return time is calculated as the time difference between specific characteristic points of the 
curve; therefore, it does not necessarily align with the other characteristic points. 

 

http://en.wikipedia.org/wiki/Computer_mouse
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o When selecting only one pulse wave at the pressure step corresponding to the 

diastolic record, several curves appear in the secondary data display: the recorded 

pulse wave (represented by a red curve), the pulse wave corresponding to the 

relevant mathematical calculations (green) and the difference of the previous two 

(black). 

 

 
 
Using the tools in the secondary data display the single pulse wave can further be examined. 
The curve can be enlarged and reduced in size within pre-set limits; see the current scale in the 
upper left-hand corner of the window. Furthermore, you can examine the curves from point to point 
by means of a cursor that can be activated. 
The secondary data display can be closed separately. 
 

The new findings of the evaluation can be saved into the database by selecting Save results… 
in the File menu or by clicking the Save results… button on the toolbar. Any previous result 

will be overwritten. 
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Different results from the ones calculated by the automatic evaluation can be saved. 
An examination is displayed with the formerly saved arterial stiffness results upon opening. If no 
result is saved, the software displays the results of the automatic evaluation. However, in this latter 
case no values will be exported with the Export command (see Section 5.4.) 
 

 
5.4.5.1 Tools for visual inspection 

 
X axis step / Horizontal axis 

The scale of the horizontal (time) axis of the pulse wave curve 
as depicted on the real-time data display can be set from 10 

ms/cm to 1,600 ms/cm in pre-defined steps. This function can be accessed directly from the toolbar 
(X axis step) or by selecting a value under Horizontal axis in the View menu. 
 
Y axis compression / Vertical axis compression 

Here the vertical (amplitude) axis of the pulse wave curve, as 
depicted on the real-time data display, can be set. The set value 

indicates the vertical compression rate of the curve. If the set value is 1, the pulse wave curve (blue) 
will be displayed in full size. This function can be accessed directly from the toolbar (Y axis 
compression) or by selecting a value under Vertical axis compression in the View menu. 
 
Baseline shift 

The pulse wave curve on the real-time data display can 
be moved upwards or downwards in relation to the zero 

line. The original position can be restored by clicking on the Reset button. 
 
View pressure curve 

 To display the actual cuff pressure values, press the View pressure curve button on the 
toolbar. When it is on, the baseline cuff pressure can be seen during the whole measurement 

on the real-time data display. 
 
Cursor 

Use the Cursor function for reading the coordinates of the oscillatory signal (pulse 
waves) and the value of the baseline cuff pressure (if the View pressure curve 

function is on).  
 

When the button is on, the cursor control tools appear. Using these, the 
cursor can be moved in single or multiple steps. 

 

Note: The cursor feature is only available at the default X axis step of 200 ms/cm.  

 

Note: Only the results of the automatic evaluation are saved automatically. For saving the results 
into the database after a manual evaluation, the Save results… command should be used. This 
allows the examiner to save the results of only those measurements that are of good enough quality 
to be exported later.  
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The above-mentioned functions are illustrated in the picture below. 

 

 
 
 

5.4.5.2 Oscillation amplitudes during blood pressure measurement 
 
By clicking on the Amps – pressure value tab of the measurement window, the maximum amplitudes 
of the oscillations recorded during the blood pressure measuring phase are depicted. The same 
function can be accessed by selecting the Amps – pressure values option under the View menu. 
By using this feature, the quality of the blood pressure measurement can be evaluated visually. 
 

 
 
 
 
 

Note: The oscillatory (blue) signals are not calibrated and therefore should not be considered to 
represent true pressure values. 
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5.4.5.3 Vascular age assessment 
 
The Vascular age assessment tab of the measurement window shows the estimated vascular age of 
the current patient. This function is found in the View menu, Vascular age assessment command. 
This tab shows the correlation between age and PWVao with smoothed reference percentile curves. 

 
The current measurement is indicated with a coloured dot on the graph, with the colour depending 
on which range the measured PWVao value falls. The ranges are the following: 

• Normal – green colour. The measured value is lower than or equal to the 50th percentile for 
that specific age group. 

• Elevated – yellow colour. The measured value is higher than the 50th percentile but lower 
than or equal to the 90th percentile for that specific age group. 

• High – red colour. The measured value is higher than the 90th percentile for that specific age 
group. 
 

 
 

5.4.6 The measurement report 

The report is a printed summary of the selected measurement results. It includes patient details, all 
the calculated hemodynamic parameters, suprasystolic and diastolic pressure curves and vascular 
age assessment. 
 
The following functions are only enabled if an examination of a patient has been selected. 
 

5.4.6.1 Edit the report 
 

 To add or edit information (notes) to the report, press the Edit report… button on the 
toolbar or select the Edit report command under the File menu. In the report window you 

Note: The percentile is a value below which a certain percentage of the known measurements fall, 
e.g. if the measured value of the current patient is in the 75th percentile, 75% of the reference test 
subjects had a lower PWVao value than the currently measured patient. The reference data (pulse 
wave curves) were derived from a healthy central - European sample including approx. 10 000 
subjects. 
Age-specific percentile curves show certain percentiles in different ages. 
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can enter your medical advice / treatment suggestions, which can be saved by clicking on Save. The 
current date can be added to the report by using the Insert date button. The edited report will 
appear on the last page of the print-out.  
 

 
 

To display institutional data on the printed report, select Setup under Tools. In the dialog box choose 
the Printed report tab where you can specify the following: 

• Doctor’s identification data 

• Department details  

Department details along with the doctor’s name and registration number will be depicted in the 
footer of the printed report. These data are user-specific and therefore will appear on the report of 
every patient of the user.  
The Operator’s name is shown in the Measurement data section of the printed report. It is 
measurement-specific, therefore can be modified for each measurement. By default, the Operator’s 
name is the login name of the User. The Operator’s name for the default user (ARTERIOGRAM) 
cannot be modified. 

 

 
 

5.4.6.2 Print the report 
 

You can print out a report by choosing Print preview and print under the File menu or 
clicking the Print preview and print button on the toolbar.  

Note: The report is assigned to a specific examination, and can be modified later. For other 
measurements of the patient this medical advice will not be saved or displayed. 
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A Print options dialog window appears where printer selection and printer settings can be made, and 
other common print options can be set. Click OK/Cancel to continue. 
 

 
 
The print preview screen appears: 
 

 
 
Using the toolbar on this screen, the following functions can be accessed: 
Zoom tool 

The print preview page can be zoomed to fit the screen height (Zoom to fit), to fit 
the screen width (Zoom to width), to the original size (100%), or a percentage 

value between 50% and 200%. 
 
Navigation tool 

This tool can be used to navigate to the First page, Previous page, Next 
page or to the Last page of the medical report. 

 
Search tool 

Using these tools, a search can be performed by page number (Go to page) or by a 
keyword (Search for text). 

 
Copy tool 

The current page of the report can be copied to the clipboard with this tool. 
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Print tool 

A printer can be selected and set up using the first icon. We recommend Microsoft 
Print to PDF, as certain pdf writer software may not depict the graphs on the 

measurement report. The page can be printed with the previously determined settings by clicking on 
the second icon. 
 
Load tool 

The patient’s previously saved reports can be selected and displayed by clicking on Load 
Report in the Print preview dialog box. 

 
Close 

The Print preview screen can be closed by using this button. 
 

 
 
The report printed by the Arteriograph software will contain the following: 
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Page 1: 

• Patient data. The patient data are shown here including a user-defined parameter and its 

value, provided it is activated (Section 5.4.1). The sections for missing or undefined data will 

remain blank.  

• Risk profile. The previously entered risk profile (see Section 5.4.2.2) is displayed here. 

• Medication. The list of medications entered previously (see Section 5.4.2.2) is depicted here. 

• Measurement data. This part contains the date and time of the examination, the name of 

the operator, and the mandatory patient data. 

• Suprasystolic record. Peripheral and central hemodynamic parameters are listed here, 

excluding pulse wave velocity. The calculated Ankle-Brachial Index (ABI) is also depicted at 

this section if this option was previously activated (see Section 5.4.1). An extract of the 

suprasystolic pulse wave is displayed with the points of the Return Time (RTS35) and Dicrotic 

notch (Ejection Duration; ED) indicated on it.  

• Diastolic record. This part contains the parameters resulting from the analysis of the pulse 

wave curves recorded at the diastolic pressure step. There are also two graphs showing an 

extract of the pulse wave curves and a single curve (the last wave if several waves are 

selected for analysis). The DRA, SAI, and DAI parameters can be obtained only if an ED value 

is available from the previous phase (Suprasystolic record).  

• Footer: 

- Institutional and operator data on the left-hand side if set (Section 5.4.6.1). 

- Manufacturer’s data complemented with the version number of the software on the 

right-hand side. 
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Page 2: 

• Suprasystolic record. The first part of this page contains the quality control of the 

measurement. An extract of the pulse wave curves recorded on the suprasystolic pressure 

step is shown in a plot to facilitate observing the quality of the waveforms. The value of SD 

PWVao is also represented here. 

• Pulse Wave Velocity measurement. This part displays the measured aortic pulse wave 

velocity and return time values. 

• PWV – Arterial Age Assessment. The current measurement is placed in an age – PWVao 

graph with smoothed reference percentile curves (see Section 5.4.5.3). The point of the 

measurement is coloured according to the ranges in the legend of the graph. The depiction is 

performed in 8-year steps. 

Under the percentile graph the mean aortic PWV value with regards to the age of the 

currently examined patient is provided. This value derives from a database involving the data 

of 60.000 patients. If the measured PWV value of the patient is lower than the mean value 

written in this sentence, the patient is in an apparently better condition than the average, if 

it is equal, than their PWV is average, and if it is higher, caution, and – possibly – lifestyle 

change is advised. The measured PWV value is depicted on a colour scale, which facilitates 

this distinction further. 

 

Note: In each case, a medical doctor’s expertise is required to evaluate the findings of the whole 
measurement. Do not attempt to interpret the measurement results and diagnose the patient 
without this knowledge! 
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Page 3: 
This page provides a concise description of the parameters depicted on the measurement report. 
This information contains the definition, normal (healthy) value range and problems regarding 
abnormal values of the parameters, literature references and any other important information. 
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Page 4: 

• Medical Report. This page includes only the patient details and the edited medical report, as 

noted by the operator. 

 
  

Note: The report is always printed out in A4 size. It contains only the previously entered 
information and the results measured or calculated during the analyses.  
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5.4.6.3 How to send a report in PDF format 

 
You can convert the above detailed report to PDF format by Send PDF report under the File menu 
and simply e-mail it. After the command is selected, the program converts the report to PDF format 
automatically.  The generated .pdf file can be saved to a selected directory with the following file 
name: Tcrep_fullname_date_time.pdf, where fullname is the name of the patient and date and time 
are the date and time of the examination in the pre-set date and time format (e.g. 
TCrep_TestElisabeth_26032007_07_43.pdf). 
As a next step the default mailing application – if there is any – is loaded automatically with the 
generated .pdf file attached to a new email, and the email can be sent to any recipient. 

5.4.7 Export the measurement data 

 
Formerly saved measurement results (see Section 5.4.5) can be exported into a formatted 
text file by choosing Export data under the Tools menu or clicking the Export data… button 

on the toolbar.  
 
Step 1 Select a user whose patients’ measurement(s) you would like to export by ticking the 

checkbox next to it. The Select all option is a quick way to select all the listed users. All 
the registered users are listed in this window. Continue by clicking on the first arrow. 
 

 
 

Step 2 Select the patient(s) whose measurement(s) you would like to export by clicking on each 
required row. All the patients belonging to the selected user are listed here in 
alphabetical order of the family name. 
If there is a great number of patients, a particular patient can be found by using the built-
in search function. For a quick search click anywhere in the patient list and type in the 
initials of the given patient’s family name. The built-in search is not case sensitive. 
A selection of any number of the patients can be performed by ticking their respective 
checkboxes. The Select all option is a quick way to select all the listed patients. Selection 
is confirmed by clicking on the second arrow. 
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Step 3 By setting a time range here, only those measurements will be exported which were 
performed in the specified range. By ticking the checkbox titled Export all measurements, 
every measurement of the formerly selected patients will be exported. Click Export to 
start the process. 
 

 
 

Step 4 The status of the export process is shown by a progress bar. In case of a large database 
the process can take several minutes. 
 

 
 

Step 5 When the export is completed, the directory should be selected where the completed 
text file will be saved. The exported file is a tab delimited text file, which can easily be 
opened or imported in common spreadsheet applications (e.g. Microsoft Excel) or most of 
the statistical packages (e.g. SPSS, SAS) 
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If the operation is successful, a message window of confirmation will pop up. 

5.4.8 Backup and restore the database 

 
To protect your measurements against accidental data loss, the database should be backed up 
regularly. For this, use the Backup command under Tools menu.  
The Backup and restore dialog window appears, where you can set whether to make or to restore a 
database. The destination directory can also be selected. 

5.4.8.1 Backup data 

In the Backup field select Create to start the backup process. Also select the destination directory for 
the backup file. 
 

 
 

If there is a previously saved backup file in the selected database, a confirmation window pops up for 
overwriting the file. If you don’t want to overwrite it, press No and rename the previous backup file 
or choose another destination directory. If you approve overwriting, simply click on Yes. To select a 
backup directory, double-click on it. Please note that the C:\ root directory cannot be used as a 
backup directory! 
 

 
 
An information window pops up if the backup is successfully completed. 
 

 
 

Note: The exported text file contains each measurement in a different row. Several 
measurements for one patient are listed under each other. If the results were not saved for a 
given measurement, the exported text file will only contain the patient data and the blood 
pressure measurement values in that row. 
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5.4.8.2 Restore data 
 

In the Backup window select Restore to start the restoration process. Then select the directory 
where the backup file created by you is located and double-click on it. 
 

 
 
A confirmation window pops up for approving the restoration. To start the restoration, click on Yes. 
Pressing No will cancel the process. 
 

 
 
Upon successful completion an information window can be seen. 
 

 
 

 

5.4.8.3 Import previous database 
 
If you have a previous version of Arteriograph database on your computer, the Convert previous 
database and import data command under Tools menu helps to convert the measurements into the 
new database format.  
Select the patient list (.pat) file in the Regisztratumok folder under the previous installation directory 
(by default: C:\\Regisztratumok) and click Open to start the import procedure. 

 
Successful conversion is confirmed by a pop-up window. 

 

  

Note: Only a database in the original installation folder can be imported. 

Note: For a large database the conversion can take several minutes. The status of the procedure 
is shown by a progress bar.  
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6. Troubleshooting 

 

Problem Possible causes What to do 

No communication 

  

The device is not successfully 
paired with the PC 

Go to Control Panel/Bluetooth 
Devices and check whether the 
device is present and paired. If not, 
follow the instructions of Section 
5.2. 

No or low batteries in the device Replace the batteries. 

The device was turned off 
Turn on the device by pressing its 
button twice. 

No arterial function 
parameters are 
displayed 

Loose cuff Tighten the cuff. 

Arrhythmia 
The method cannot reliably assess 
arterial function parameters for 
arrhythmic patients. 

Tremor 
If possible, try to terminate 
tremor. 

No print preview 
No printer has been installed to 
the PC. 

Install a printer or use the built-in 
virtual printer of Windows. 

The PDF report cannot 
be opened 

Adobe Reader is not installed to 
the PC. 

Download and install the latest 
version of Adobe Reader. 

Database import 
cannot be completed 

Not the proper database was 
selected, or the database was 
damaged. 

Import the database by following 
the instructions of Section 5.4.8.3. 

Cannot send e-mail 
successfully 

No mailing application is installed 
to the PC. 

Install a mailing application and set 
it as default. 
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Error messages 
 

Error codes, as shown on the LCD, and their explanation are specified below. It 
should be noted that errors can occur due to patient movement causing artefacts 
in the reading. If the device cannot measure blood pressure (e.g. due to motion), 
the measurement will be disrupted.  

Example: 

 

 

The codes of the error instances indicated by the device shall mean the following: 
 
1 Measuring time exceeded The device could not measure the patient’s blood pressure 

within the pre-set time.  
 

3 Low battery The measurement was disrupted because of low battery. 
 

31 Cuff missing The cuff is not connected to the device. 
 

32 Cuff clogged The rubber hose of the cuff is blocked, or something is 
occluding the hose. 
 

33 Air leakage The cuff (or the device) leaks. 
 

34 The cuff is not on the arm While connected to the device, the cuff is not placed on the 
patient. 
 

35 Measurement disrupted For some reason (e.g. the user presses the button) the 
measurement is disrupted. 
 

37 The cuff pressure has exceeded 
300mmHg 

During the blood pressure measurement, the cuff pressure has 
reached or exceeded the maximum permitted pressure of 
300mmHg 's value. 
 

90-99 Device error The blood pressure measurement failed because of a device 
error which indicates the need for servicing, or the battery is 
low. 
 

100 Incorrect measurement result The calculated results cannot be considered as a proper blood 
pressure value, or the patient is suffering from arrhythmia. 
 

101 Motion The measurement conditions, e.g. the patient’s movement 
interfere with the process of data collection. 
 

102 No pulse detected For unknown reasons the device does not detect the cardiac 
pulses. 
 

110 Erroneous measurement result The signals are insufficient for blood pressure calculation. 
(Artefacts, arrhythmia.) 
 

111 
112 
113 

 Invalid measurement result The calculated results cannot be considered as real blood 
pressure values. (The most likely reason is noisy measurement 
signals.) 
 

115 Unacceptable measurement result The pulse rate cannot be calculated or cannot be considered as 
a real value. 
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7. Technical Specification 

 
Power supply: 
 Four AA long-life alkaline batteries 
Protection against electric shock: 
 Internal supply by batteries 
Grade of protection against electric shock: 
 BF type on patient’s side 
Display: 
 Liquid Crystal Display (LCD) 
Data storage: 
 EEPROM 
Data transmission: 
 Radio, Bluetooth 
PC Interface: 
 Bluetooth Communication  
PC system requirements: 
 Windows 10 or 11 OS installed  
Operating ambient temperature and humidity: 
 10 – 40 °C (50 – 104 °F); 15 – 85 % non-condensing  
Operating pressure range: 
 700 hPa – 1060 hPa 
Transport, storage temperature and humidity: 
                  -20 – 50 °C (-4 – 122 °F); 15 – 85 % non-condensing 
Dimensions: 
 116 x 94 x 47mm 
Weight (incl. batteries): 
 250g 
Blood pressure measuring method: 
 Oscillometric 
Sampling frequency: 
 200Hz 
Blood pressure (BP) and heart rate (HR) measuring range: 
 BP 30 – 280 mmHg; HR 40 – 200 / min 
Static accuracy: 
 ± 3mmHg or ±2% of the measured value (Stability: 18 months) 
Measurement accuracy: 
 Systolic: 

91 (91%) out of 99 comparative checks fall within 5 mmHg, 
For 33 patients out of 33, 2 of 3 comparative checks fall within 5 mmHg, 
0 of 33 patients did not have a value within 5 mmHg after 3 measurements. 
Diastolic: 
97 (98%) out of 99 comparative checks fall within 5 mmHg, 
For 33 patients out of 33, 2 of 3 comparative checks within 5 mmHg, 
0 of 33 patients did not have a value within 5 mmHg after 3 measurements. 
Average deviation from auscultatory measurements (Korotkov sounds): 
(systolic/diastolic): 0.4/-0.3 mmHg 
Standard deviation (systolic/diastolic): 2.7/2.3 mmHg 

Pressure sensor: 
 Piezo-resistive 
Inflation: 
 Automatic motor-driven pump 
Safety: 
 Maximum cuff pressure: 300 mmHg; Maximum measurement time: 180 seconds 
Deflation: 
 Automatic, stepwise 
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7.1 Electromagnetic compatibility 

 
 

Electromagnetic emissions 

The Arteriograph device is intended for use in the electromagnetic environment specified below. The customer or the user of the device 
should assure that it is used in such an environment. 

Emissions test Compliance Electromagnetic environment - guidance 
RF emissions 
CISPR 11:2009 +A1:2010 

Group 1 The Arteriograph device uses RF energy only for its 
internal function. Therefore, its RF emissions are very 
low and are not likely to cause any interference in 
nearby electronic equipment. 

RF emissions 
CISPR 11:2009 +A1:2010 

Class B The Arteriograph device is suitable for use in all 
establishments, including domestic establishments and 
those directly connected to the public low-voltage 
power supply network that supplies buildings used for 
domestic purposes. 

Harmonic emissions 
IEC 61000-3-2:2005 +A1:2008+A2:2009 

Not applicable 

Voltage fluctuations / flicker emissions 
IEC 61000-3-3:2013 

Not applicable 

 
 

Electromagnetic immunity 

The Arteriograph device is intended for use in the electromagnetic environment specified below. The customer or the user of the device 
should assure that it is used in such an environment. 

Immunity test IEC 60601 test level Compliance level 
Electromagnetic environment - 

guidance 
Electrostatic discharge (ESD)  
IEC 61000-4-2:2008 

± 8 kV contact 
± 2 kV, ± 4 kV, ± 8 kV, ± 15 kV 
air 

Conducted 
discharge: ±8 kV 
Air discharge:  
± 2 kV, ± 4 kV, ± 8 kV, 
± 15 kV 

Floors should be wood, concrete, or ceramic 
tile. If floors are covered with synthetic 
material, the relative humidity should be at 
least 30 %. 

Electrical fast transients/bursts 
IEC 61000-4-4:2012 

± 2 kV for power supply lines 
± 1 kV for input/output lines 

Not applicable - 

Surges 
IEC 61000-4-5:2005 

±0,5 kV, ±1 kV line-to-line 
±0,5 kV, ±1 kV, ±2 kV line-to-
ground 
± 2 kV for input/output parts 

Not applicable - 

Voltage dips, short interruptions 
and voltage variations on power 
supply input lines 
IEC 61000-4-11:2004 

0 % UT; 0,5 cycle 
At 0°, 45°, 90°, 135°, 180°, 
225°, 270° and 315° 
 
0 % UT; 1 cycle 
and 
70 % UT; 25/30 cycles  
Single phase: at 0° 
 

Not applicable - 

Power frequency  
(50/60 Hz)  
magnetic field 
IEC 61000-4-8:2009 

30 A/m Test level: 30 A/m 
Test time: 60 s 

If image distortion occurs, it may be 
necessary to position the Arteriograph 
device further from sources of power 
frequency magnetic fields or to install 
magnetic shielding. The power frequency 
magnetic field should be measured in the 
intended installation location to assure that 
it is sufficiently low. 

NOTE: UT is the AC mains voltage prior to application of the test level. 

   



 

 
58 

TensioMed Arteriograph-02v14-00 

 

Electromagnetic immunity 

The Arteriograph device is intended for use in the electromagnetic environment specified below. The customer or the user of the device 
should assure that it is used in such an environment. 

Immunity test IEC 60601 test level Compliance level Electromagnetic environment — guidance 
   Portable and mobile RF communications 

equipment should be used no closer to any part of 
the Arteriograph device, including cables, than the 
recommended separation distance calculated from 
the equation applicable to the frequency of the 
transmitter. 
 
Recommended separation distance 
 

𝑑 =
6

𝐸
∗ √𝑃 = 2 ∗ √𝑃 

 
 

𝑑 =
6

𝐸
∗ √𝑃 = 2 ∗ √𝑃 

 

where P is the maximum output power rating 
of the transmitter in watts (W) according to 
the transmitter manufacturer, E is the 

immunity test level and d is the 
recommended separation distance in metres 
(m). 
Field strengths from fixed RF transmitters, as 
determined by an electromagnetic site 
survey,a should be less than the compliance 
level in each frequency range.b 

Interference may occur in the vicinity of 
equipment marked with the following symbol: 
 

Conducted RF  
IEC 61000-4-6:2013 

1 Veff 
150 kHz – 80 MHz 
 

3 V 
 

 
 

Radiated RF 
IEC 61000-4-3:2006 
+A1:2007+A2:2010 

3 V/m 
80 MHz – 2,7 GHz 
80 % AM at 1 kHz 

3 V/m  
on 

80 – 1000 MHz and 
1,0 – 2,7 GHz 

frequency ranges 
AM 1 kHz 80 % 

NOTE 1   At 80 MHz and 800 MHz, the higher frequency range applies. 
NOTE 2 These guidelines do not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from 
structures, objects, and people. 
a Field strength from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur 
radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic 
environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the 
location in which the Arteriograph device is used, exceeds the applicable RF compliance level above, the device should be observed to 
verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as re-orienting or relocating 
the Arteriograph device. 
b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m. 

 
Recommended separation distances between portable and mobile RF communications equipment and the 

Arteriograph device 
The Arteriograph device is intended for use in an electromagnetic environment in which radiated RF disturbances are controlled. The 
customer or the user of the device can help prevent electromagnetic interference by maintaining a minimum distance between portable 
and mobile RF communications equipment (transmitters) and the Arteriograph device as recommended below, according to the 
maximum output power of the communications equipment. 

Rated maximum output 
power of transmitter 

W 

Separation distance according to frequency of transmitter 
m 

150 kHz – 80 MHz 

d= 2√P 

80 MHz – 800 MHz 

d= 2√P 

800 MHz – 2,5 GHz 

d=2√P 
0,01 0,2 0,2 0,2 

0,1 0,63 0,63 0,63 

1 2 2 2 

10 6,32 6,32 6,32 

100 20 20 20 

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in metres (m) can be 

estimated using the equation applicable to the frequency of the transmitter, where P is the maximum output power rating of the 

transmitter in watts (W) according to the transmitter manufacturer. 

NOTE 1 At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies. 
NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from 
structures, objects, and people. 



 

 

 7.2 Use Specification 

 

Intended medical indication Non-invasive determination of brachial 
blood pressure, heart rate, and central 
hemodynamic parameters in a medical 
office. Only a medical professional is 
allowed to evaluate the measurement 
results! Assessing the hemodynamic 
parameters affected by various factors of 
the patients’ arterial circulation. The 
contraindications are listed in sections 1.1. 
and 1.5. 

Intended patient population Cannot be used on patients under 3 years of 
age. Clinically validated on a patient 
population above 3 years of age. 

Intended part of the body or type  
of tissue applied to or interacted with 

The cuff interacts with the skin surface of 
the upper arm or the ankle and exerts 
pressure on it when the device is in use. 

Intended user profile Physician, medical staff. 

Use environment Medical outpatient, medical diagnosis 
where applicable. See sections 1.1. and 1.5. 
for details. 

Operating principle Oscillometric method 

 
  



 

 

 


